Chapter 202

Conditional Power of Two Proportions Tests

Introduction

In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow and Chang (2007), Chang (2008), Proschan et.al (2006), and Dmitrienko et.al (2005).

This program module computes conditional and predicted power for the case when a \( z \) test is used to test whether the event probabilities of two populations are different.

Technical Details

All details and assumptions usually made when using a two-sample \( z \)-test to test the difference between two proportions continue to be in force here.

Conditional Power

The power of an experiment indicates whether a study is likely to result in useful results, given the sample size. Low power means that the study is futile: little chance of statistical significance even though the alternative hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the study has started. When this happens, the study is curtailed.

The futility of a study that is underway can be determined by calculating its conditional power: the probability of statistical significance at the completion of the study given the data obtained so far.

It is important to note that conditional power at the beginning of the study before any data are collected is equal to the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional power will seldom result in study curtailment very early in the study.

From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage \( k \) for rejecting a null hypothesis about a parameter \( \theta \) at the end of the study, given the observed test statistic, \( Z_k \), is computed as

\[
P_{\text{alc}}(\theta) = \Phi\left( \frac{Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_k} + \theta(I_k - I_k)}{\sqrt{I_k - I_k}} \right),
\]
Conditional Power of Two Proportions Tests

the general lower one-sided conditional power at stage $k$ is computed as

$$P_k(\theta) = \Phi\left(\frac{-Z_k \sqrt{I_k} - z_{\alpha} \sqrt{I_K} - \theta(I_K - I_k)}{\sqrt{I_K - I_k}}\right),$$

and the general two-sided conditional power at stage $k$ is computed as

$$P_k(\theta) = \Phi\left(\frac{Z_k \sqrt{I_k} - z_{\alpha/2} \sqrt{I_K} + \theta(I_K - I_k)}{\sqrt{I_K - I_k}}\right) + \Phi\left(\frac{-Z_k \sqrt{I_k} - z_{\alpha/2} \sqrt{I_K} - \theta(I_K - I_k)}{\sqrt{I_K - I_k}}\right),$$

where

$\theta = $ the parameter being tested by the hypothesis

$k = $ an interim stage at which the conditional power is computed ($k = 1, \ldots, K - 1$)

$K = $ the stage at which the study is terminated and the final test computed

$Z_k = $ the test statistic calculated from the observed data that has been collected up to stage $k$

$I_k = $ the information level at stage $k$

$I_K = $ the information level at the end of the study

$z_{\alpha} = $ the standard normal value for the test with a type I error rate of $\alpha$.

For a test of a two proportions with null hypothesis $H_0: P_1 = P_2$, where $P_1$ and $P_2$ are the population proportions in groups 1 and 2, respectively, under the alternative hypothesis, these components are computed in Chang (2008) pages 70 and 71 as

$\theta = P_2 - P_1$ (the expected difference under the alternative hypothesis)

$Z_k = (p_{2k} - p_{1k}) \sqrt{\hat{I}_k}$ (the $z$ statistic computed from the observed data)

$I_k = \frac{1}{\sigma^2} \left(\frac{1}{n_{1k}} + \frac{1}{n_{2k}}\right)^{-1}$ (the interim information level)

$I_K = \frac{1}{\sigma^2} \left(\frac{1}{n_1} + \frac{1}{n_2}\right)^{-1}$ (the final information level)

where

$p_{jk}$ is the sample proportion for group $j$, estimating $P_j$ at stage $k$

$\hat{I}_k$ is the estimated information from the sample at stage $k$

$n_{jk}$ is the sample size in group $j$ at stage $k$

$n_j$ is the final sample size in group $j$

$\sigma^2 = \bar{p}(1 - \bar{p})$ with $\bar{p} = (P_1 + P_2)/2$

Computing conditional power requires you to set $P_1$ and $P_2$. Their values can come from the values used during the planning of the study, from similar studies, or from estimates made from the data that has emerged.
Futility Index

The *futility index* is $1 - P_k(\theta) | H_a$. The study may be stopped if this index is above 0.8 or 0.9 (that is, if conditional power falls below 0.2 or 0.1).

Predictive Power

*Predictive power* (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power at stage $k$ is given by

$$P_{uk} = \Phi \left( \frac{Z_k \sqrt{I_K} - z_{1-\alpha} \sqrt{I_k}}{\sqrt{I_K - I_k}} \right).$$

the general lower one-sided predictive power at stage $k$ is given by

$$P_{lk} = \Phi \left( -\frac{Z_k \sqrt{I_K} - z_{1-\alpha} \sqrt{I_k}}{\sqrt{I_K - I_k}} \right),$$

the general two-sided predictive power at stage $k$ is given by

$$P_k = \Phi \left( \frac{Z_k \sqrt{I_K} - z_{1-\alpha/2} \sqrt{I_k}}{\sqrt{I_K - I_k}} \right) + \Phi \left( -\frac{Z_k \sqrt{I_K} - z_{1-\alpha/2} \sqrt{I_k}}{\sqrt{I_K - I_k}} \right),$$

with all terms defined as in the equations for conditional power.

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Test

Alternative Hypothesis

Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite, specifying the alternative is all that is needed.

When you choose a one-sided test option, you must be sure that the value(s) of P1 and P2 match your choice. For example, if you select $Ha: P1 < P2$, the values of P1 must be less than P2.
Conditional Power of Two Proportions Tests

**Alpha**

This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025 for one-sided tests.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

**Sample Size**

**N1 (Group 1 Target Sample Size)**

Enter one or more values of the target sample size of group 1, the total number of subjects planned for this group. This value must be an integer greater than one. Note that you may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.

**N2 (Group 2 Target Sample Size)**

Enter a value (or range of values) for the target sample size of group 2 or enter Use R to calculate N2 from N1. You may enter a range of values such as 10 to 100 by 10.

- **Use R**
  
  If Use R is entered here, N2 is calculated using the formula
  
  \[ N2 = \left\lceil R(N1) \right\rceil \]
  
  where R is the Sample Allocation Ratio and the operator \( \left\lceil \right\rceil \) is the first integer greater than or equal to \( Y \). For example, if you want \( N1 = N2 \), select Use R and set \( R = 1 \).

**R (Sample Allocation Ratio)**

Enter a value (or range of values) for R, the allocation ratio between samples. This value is only used when N2 is set to Use R.

When used, N2 is calculated from N1 using the formula: \( N2 = \left\lceil R(N1) \right\rceil \) where \( \left\lceil \right\rceil \) is the next integer greater than or equal to \( Y \). Note that setting \( R = 1.0 \) forces \( N2 = N1 \).

**n1k (Group 1 Sample Size at k)**

Enter the group 1 sample size obtained through look k. If this value is greater than N1, the value of N1 is increased to this amount.

**n2k (Group 2 Sample Size at k)**

Enter the group 2 sample size obtained through look k. If this value is greater than N2, the value of N2 is increased to this amount.

- **n1k**
  
  If n1k is entered here, n2k is set equal to n1k.
Effect Size – Proportions

P1 (Proportion Group 1)
Enter one or more values for the probability of obtaining a success in group 1. This is the proportion of the group 1 population with the trait of interest.

You may enter a range of values such as 0.4 0.5 0.6 or 0.4 to 0.7 by 0.1. Since this is a proportion, all values must be between 0 and 1.

P2 (Proportion Group 2)
Enter one or more values for the probability of obtaining a success in group 2 assuming the alternative hypothesis. This is the proportion of the group 2 population with the trait of interest.

You may enter a range of values such as 0.4 0.5 0.6 or 0.4 to 0.7 by 0.1. Since this is a proportion, all values must be between 0 and 1.

Effect Size – Current Test Statistic

Zk (Current Test Statistic)
Enter the value of the z statistic calculated from the data obtained through stage k. This value may be positive or negative. Typically, the z statistic ranges between -5 and 5.
Example 1 – Computing Conditional Power

Suppose a study has been planned to detect a change in proportions of 10 percentage points from $P_1 = 0.6$ to $P_2 = 0.7$ at an alpha of 0.025 using a one-sided $z$-test. The target sample size is 60 (30 per group). An interim analysis is planned after half the data have been collected. The data monitoring board would like to have the conditional power calculated for $z$ values of 0, 0.5, 1, 1.5, 2, and 2.5.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Conditional Power of Two Proportions Tests procedure window by expanding Proportions, then Two Independent Proportions, then clicking on Conditional Power, and then clicking on Conditional Power of Two Proportions Tests. You may make the appropriate entries as listed below or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>$H_a: P_1 &lt; P_2$ (One-Sided)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>N1 (Group 1 Target Sample Size)</td>
<td>60</td>
</tr>
<tr>
<td>N2 (Group 2 Target Sample Size Group 2)</td>
<td>Use R</td>
</tr>
<tr>
<td>R (Sample Allocation Ratio)</td>
<td>1.0</td>
</tr>
<tr>
<td>$n_1k$ (Group 1 Sample Size at k)</td>
<td>30</td>
</tr>
<tr>
<td>$n_2k$ (Group 2 Sample Size at k)</td>
<td>$n_1k$</td>
</tr>
<tr>
<td>$P_1$ (Proportion Group 1)</td>
<td>0.6</td>
</tr>
<tr>
<td>$P_2$ (Proportion Group 2)</td>
<td>0.7</td>
</tr>
<tr>
<td>$Z_k$ (Current Test Statistic)</td>
<td>0 0.5 1 1.5 2 2.5</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.02501</td>
<td>0.02500</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.6</td>
<td>0.7</td>
<td>0.000</td>
<td>0.02500</td>
</tr>
<tr>
<td>0.07217</td>
<td>0.10513</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.6</td>
<td>0.7</td>
<td>0.500</td>
<td>0.02500</td>
</tr>
<tr>
<td>0.16858</td>
<td>0.23262</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.6</td>
<td>0.7</td>
<td>1.000</td>
<td>0.02500</td>
</tr>
<tr>
<td>0.32283</td>
<td>0.56409</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.6</td>
<td>0.7</td>
<td>1.500</td>
<td>0.02500</td>
</tr>
<tr>
<td>0.51603</td>
<td>0.80743</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.6</td>
<td>0.7</td>
<td>2.000</td>
<td>0.02500</td>
</tr>
<tr>
<td>0.70547</td>
<td>0.94244</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.6</td>
<td>0.7</td>
<td>2.500</td>
<td>0.02500</td>
</tr>
</tbody>
</table>

References

Report Definitions
Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the data that have emerged so far.
Predicted Power is the average conditional power, averaged over the effect size.
N1|N2 are the anticipated total sample sizes of groups 1 and 2.
n1k|n2k are the sample sizes of groups 1 and 2 obtained through stage k.
P1 is the response proportion for groups 1 and 2 under the null hypothesis.
P2 is the response proportion for group 2 under the alternative hypothesis.
Zk is the value of the test statistic from the observed data at stage k.
Alpha is the probability of rejecting a true null hypothesis.
Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be stopped because there is little chance of achieving statistical significance.

Summary Statements
The first 30 of 60 subjects in group 1 and 30 of 60 subjects in group 2 achieve 3% conditional power to detect a difference of 0.1 at a significance level of 0.02500 using a one-sided test.
The value of the proportion in group 1 under the alternative hypothesis is 0.6. The value of the proportion in group 2 under the alternative hypothesis is 0.7. The value of the test statistic, Zk, from data that have emerged through look k is 0.000. The futility index is 0.97499.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and Zk.
Example 2 – Validation

We could not find an example of a conditional power calculation for a two-sample proportions test in the literature. Since the calculations are relatively simple, we will validate the calculation of the third scenario ($Z_k = 1$) of Example 1 by hand.

In this case

$$I_k = \frac{1}{\sigma^2} \left( \frac{1}{n_{1k}} + \frac{1}{n_{2k}} \right)^{-1} \quad I_K = \frac{1}{\sigma^2} \left( \frac{1}{n_1} + \frac{1}{n_2} \right)^{-1}$$

$$= \frac{1}{0.65(0.35)} \left( \frac{1}{30} + \frac{1}{30} \right)^{-1} \quad = \frac{1}{0.65(0.35)} \left( \frac{1}{60} + \frac{1}{60} \right)^{-1}$$

$$= 65.93406593 \quad = 131.86813187$$

$$P_{nk}(\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - Z_{1-\alpha} \sqrt{I_K} + \theta(I_K - I_k)}{\sqrt{I_K - I_k}} \right)$$

$$= \Phi \left( \frac{1.0 \sqrt{65.93406593} - (1.9599640) \sqrt{131.86813187} + (0.7 - 0.6)(131.86813187 - 65.93406593)}{\sqrt{131.86813187 - 65.93406593}} \right)$$

$$= \Phi \left( \frac{-7.79363524}{8.11997943} \right)$$

$$= \Phi(-0.95980972)$$

$$= 0.16857549$$

This value matches the third line of the report in Example 1.